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Abstrakt 

Tato bakalářská práce se zabývá psaním rozšíření pro MS Outlook. Jejím cílem je projít 

možné způsoby, jak psát rozšíření pro MS Outlook. Následně vytvořit sadu příkladů využívajících 

tyto postupy a demonstrovat je, včetně praktických ukázek. Bakalářská práce má sloužit budoucím 

vývojářům těchto rozšíření, kteří však nemají doposud žádné zkušenosti s tímto tématem. Bude 

sloužit jako publikace, která je seznámí s daným tématem a ukáže základní možnosti psaní rozšíření. 

Abstract 

This bachelor's thesis is concerned with the writing of add-ons for MS Outlook. It has an 

objective of discussing the possible manners of writing add-ons for MS Outlook. Furthermore, it 

provides a set of examples using these procedures and demonstrates them, including practical 

exemplification. The bachelor's thesis is intended to serve future developers of the add-ons concerned 

who have no previous experience in this area. It will serve as a publication which will acquaint them 

with the subject and show the basic possibilities of writing add-ons. 
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1 Úvod 

V dnešní době patří emailová komunikace ke každodenním činnostem, jejíž používání 

usnadňují emailový klienti. Ti však nemohou svými vestavěnými funkcemi plně pokrýt nejrůznější 

potřeby všech jejich uživatelů, a proto určitě spoustu z nás napadlo, zda by poštovní klient nemohl 

umět ještě něco navíc. Z tohoto důvodu jsem se rozhodl, zabývat se tímto tématem v mojí bakalářské 

práci. 

Pracovat budeme s klientem MS Outlook 2007 a postupně si projdeme možnosti psaní 

pluginů od jednoduchých skriptů, až po složitější pluginy v podobě sdílených D L L knihoven. 

Seznámíme se také s distribucí napsaných kódů a jejich instalací. Na jednoduchých příkladech si 

ukážeme možnosti pluginů, jako např.: přizpůsobení Ribbon funkcí, úprava aplikačního menu, úprava 

panelu nástrojů, či spolupráce s dalšími aplikacemi ze sady MS Office 2007. 
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2 Možnosti psaní pluginů 

Plugin nebo též add-in je zásuvný modul, který rozšiřuje standardních funkce. Vytváření 

pluginů pro MS Outlook se dělí na dva hlavní směry, a to buď na pluginy tvořené pomocí V B A 

(Visual Basic for Applications) a úprav formulářů, napsané přímo ve vývojovém prostředí 

integrovaném v Outlooku, nebo napsané ve formě C O M (Component Object Model) Add-in, jedná se 

o D L L knihovnu nebo spustitelný soubor (EXE). Každá z těchto možností má své výhody i 

nevýhody, které si postupně představíme, popíšeme a rozebereme. 

Před samotným začátkem psaní si musíme rozmyslet rozsah, účel i požadavky na bezpečnost 

kódu atd. Na základě těchto požadavků vybereme, jednu z předchozích možností. Pro psaní kratších a 

jednodušších kódů, kde nepotřebujeme chránit napsaný kód, je vhodnější využít maker. Naopak C O M 

Add-in využijeme všude tam, kde je potřeba chránit obsah vytvářeného pluginů. Mezi typická užití 

C O M Add-in patří: 

• přidávání tlačítek a nabídek na Panel nástrojů 

• reakce na události vyvolané v Outlook Application object 

• reakce na další události z Outlook Object Model 

• rozšíření funkcí pomocí formulářů 

• práce s rozhraním ribbon 

2.1 Úprava Outlook formulářů 

První možnost jak napsat plugin pro Outlook je, upravit si jeho formuláře s využitím 

integrovaných nástrojů. Cokoli co otevřeme v Outlooku, jako např.: emailová zpráva, kontakty, 

kalendář atd., je možné upravit. Můžeme přidávat či odebírat data, která tyto formuláře zobrazují, 

reagovat na uživatelský vstup a spouštět další činnosti Outlooku. Podrobněji se úpravě formulářů 

budeme věnovat v kapitole 3. pomocí C O M Add-in. 
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Phone numbers — 

! Business., r703] 555-1234 

Home., 

Business Fax.,. 

Mobile... 

Addresses 

! Business., 

IThis is the mailing 
address 

Obr. 2.1 Upravený formulář [1] 

2.2 Visual Basic for Applications 

Typické použití V B A: 

• správa a údržba emailů (hromadné mazání příloh či celých emailů, přesouvání emailů 

do složek) 

• zpracování a filtrování emailů 

• vyhledávání v kalendáři a kontaktech 

• spolupráce s dalšími aplikacemi ze sady Office (obsah emailu překopírovat do Excelu 

pro další zpracování) 

Velkou výhodou tohoto způsobu vytvářeni pluginů je, že veškeré potřebné nástroje pro psaní 

kódu jsou integrovány přímo v Outlooku. Je zde vývojové prostření pro tvorbu maker, odchytávání 

událostí a tvorbu procedur. Integrované nástroje pro psaní pomocí V B A : 

• Visual forms designer (pro vytváření dialogových oken ve V B A , nedají se zde 

upravovat formuláře v Outlooku) 

• editor kódu se zvýrazňováním syntaxe 

• a další 
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Microsoft Visual Basic VbaProject.OTM 
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Pub l i c Sub I n i t i a l i z e _ h a n d l e r [ ] 
Set- iiiyApp = Ou t look .App l i c a t 

End Sub  

P r i va te Sub iiiyApp_ItemSend(ByVal Item As Object , Cancel As Boolean) 
Dim text As S t r i n g 
text = "Opravdu chceš odes la t email " 4 I tem.Subject £ "?" 
If HsgBox[text, vbYesNo + vbOuest ion , "Odeslat? " ) = vbNo Then 

Cancel - True 
End If 

End Sub 

vate Sub Appl. icatigrí^.IteeiSénd (ByVal Item As Object , Cancel As Boole 
Dim text As S t r i n g 
text = "Opravdu chceš odes la t email " 4 I tem.Subject £ "?" 
If HsgBoxftext, vbYesNo + vbQuest ion , "Odeslat? " ) = vbNo Then 

Cancel = True 
End If 

Sub HelloIJocldllessage [) 
Dim msg As Out look.Ha i l I tem 
Set msg = App l i ca t ion .C rea te l t em(o lHa i l I t em) 
msg.Subject = "He l l o U o r l d . . . " 
msg.D.isplay 
Set msg = Nothing 

End Sub 

Sub TaskFormf) 
Dim task As Out look.Taskl tem 

Set task = Appl i ca t ion .Grea te l tem[o lTask l tem] 
t ask .Sub jec t - "Aho j " 
t a s k . D i s p l a y 
Set task = Nothing 

Obr 2.2 Editor VESA 

Naopak nevýhodou tohoto způsobu psaní pluginů je, že zdrojový kód je možné prohlížet, 

upravovat a kopírovat. 

2.2.1 Distribuce kódu 

Kód V B A byl navržen pro osobní použití, proto se nepočítalo s jeho distribucí mezi velké 

množství uživatelů. Kód V B A tak můžeme distribuovat pouze dvěma možnostmi: distribucí pomocí 

exportu a importu modulu nebo zkopírováním souboru VbaProject.OTM. Veškerý napsaný kód se 

ukládá do jediného souboru VbaProject.Otm, umístěného ve složce: \Documents and 
Settings\%uživatel%\Data a p l i k a c i \ M i c r o s o f t\Outlook:\VbaProj e c t . OTM 

Informace z podkapitoly 2.2 jsem čerpal z [2]. 

2.2.1.1 Distribuce pomocí exportu a importu modulu 

Nejjednodušší možností, jak distribuovat napsaný kód, je využít exportu v integrovaném 

editoru. Z důvodu, že stačí vybrat pouze z nabídky File->Export File... nebo využít klávesovou 

zkratku Ctrl+E. Jestliže hodláme distribuovat také dialogová okna, je potřeba poslat jak soubor *.frm, 

tak také soubor * .frx. 
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Nevýhody tohoto způsobu distribuce jsou: 

• nepříjemný a zdlouhavý proces v případě většího množství modulů 

• jestliže exportujeme ThisOutlookSession modul, uživateli se při importu změní název 

modulu na ThisOutlookSession 1, takže kód nebude spouštěn automaticky jako 

v případě ThisOutlookSession 

• uživatel musí vyřešit shodné názvy procedur mezi importovaným kódem a kódem již 

existujícím ručně 

2.2.1.2 Zkopírování souboru VbaProject.OTM 

Jelikož je veškerý kód uložen v jediném souboru, nabízí se vcelku jednoduchá možnost a tou 

je zkopírování celého souboru s kódem. 

Ovšem i tato metoda má své nevýhody: 

• veškerá dosud napsaná makra budou přepsána 

• v Outlooku 2000 a 2002 musí uživatel kód spustit ručně pomocí Alt + F8 [2] 

2.2.2 Příklady 

V této kapitole si ukážeme několik příkladů s kódem a také, jak tento kód spouštět. Makra 

můžeme v podstatě rozdělit na dvě kategorie. 

První z nich jsou makra pracující automaticky po startu Outlooku. Tyto makra zpravidla 

reagují na události generované Outlookem, které následně zpracovávají, jako např.: příchod emailu 

nebo odeslání emailu. 

Druhou skupinou jsou makra, která jsou spouštěna uživatelem. Ty mohou také reagovat na 

události, ale až po jejich ruční aktivaci. 

2.2.2.1 Hello World 

První marko, které si ukážeme je "Hello World!". Nejdříve spustíme editor V B A 

Tools ->Macro->Visual Basic Editor nebo pomocí klávesové zkratky A l t + F l l . Po spuštění tohoto 

makra se zobrazí dialog s textem „Hello World!". 

Sub HelloWorld() 
MsgBox ("Hello World!") 

End Sub 
Obr. 2.3 Hello World! 
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2.2.2.2 Vytvoření nové zprávy 

Začneme makrem, které vytvoří novou zprávu a vepíše do ní příjemce, předmět a obsah. 

Tímto postupem můžeme zefektivnit naši práci, zejména, pokud často komunikujeme se stejnou 

skupinou lidí či odesíláme v příloze stále stejné soubory. 

Sub NeuMessage() 
Dirn rnsg As Outlook. Mail Itern 
Set rnsg = Application. Createltern (olMailItern) 
insg.Subject = "Pozdrav" 
rnsg.To = "xfajtOOSstud.fit .vutbr.cz" 
msg.Body = "Dobry den." 
insg. Display 
Set rnsg = Nothing" 

End Sub 

Obr. 2.4 Makro - Nová zpráva 

2.2.2.3 Zpracování událostí 

Události generované Outlookem můžeme zpracovávat automaticky po startu nebo až po 

aktivaci uživatelem. Jestliže chceme odchytávat událost automaticky po startu Outlooku, složíme 

název obslužné procedury následovně Application_JménoObsluhovanéUdálosti . 
V této ukázce budeme zpracovávat událost ItemSend. Událost je generována ještě před 

odesláním emailu. Celé makro pak bude před odesláním každého emailu chtít potvrzení od uživatele, 

že email chce skutečně odeslat. 

P r i v á t e Sub Application_IternSend (ByVal Itern As Object , Cancel As Boolean) 
Dirn text As S t r i n g 
text = "Opravdu c h c e š odeslat email " £ Itern. Subject £ "?" 
If MsgBox(text, vbYesNo + vbQuestion, "Odeslat?") = vbNo Then 

Cancel = True 
End If 

End Sub 

Obr. 2.5 Makro - Automatické zpracování události 

Jestliže však potřebujeme zpracovávat události až po aktivaci uživatelem, musíme nejdříve 

vytvořit proměnou pro práci s událostmi, inicializovat pro odchytávání událostí (provede uživatel) a 

napsat obslužnou proceduru, jejíž jméno bude složeno následujícím způsobem: 

JménoProměnné JménoObsluhovanéUdálosti. 
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Publ ic WithEvents myApp As Outlook. A p p l i c a t i o n 

Publ ic Sub I n i t i a l i s e _ h a n d l e r () 
Set rnyApp = Outlook. A p p l i c a t i o n 

End Sub 

Private Sub myApp_ItemSend (ByVal Item As Object , Cancel As Boolean) 
Dim text As S t r i n g 
text = "Opravdu c h c e š odeslat email " £ Item.Subject £ "?" 
If MsgBoxftext, vbYesNo + vbQuestion, "Odeslat?") = vbNo Then 

Cancel = True 
End If 

End Sub 

Obr. 2.6 Makro - Uživatelem spuštěná obsluha události 

2.2.2.4 Spouštění dalších aplikací ze sady MS Office 

Další skupinou maker, kterou můžeme vytvořit, jsou makra spolupracující s dalšími 

aplikacemi ze sady MS Office. Můžeme jednoduše spustit Word či Excel a předvyplnit je údaji 

z příchozí zprávy. V našem příkladu si ukážeme spuštění MS Word. Vytvoříme dva objekty, jeden 

bude reprezentovat aplikaci Word, druhý bude dokument aplikace Word. 
Sub WordDoc() 

Dim wApp As Object 1 Aplikace Word 
Dim wDoc As Object 1 Dokument 
Set wApp = CreateObject("Word.Application") 1 S p u š t ě n i wordu 
Set wDoc = wApp.Documents.Add ' v y t v o ř e n i nového dokumentu 
wApp.Visible = True 
Set wApp = Nothing 
Set wDoc = Nothing 

End Sub 

Obr. 2.7 Makro - Spuštěni Wordu 

2.2.2.5 Vytvoření dialogového okna 

Doposud napsaná makra sloužila k automatizaci a zefektivnění naší práce s Outlookem, 

někdy ale potřebujeme interakci s uživatelem např.: zadat určitá data. A právě k tomuto účelu 

vytvoříme dialogové okno. Nejprve spustíme editor V B A a v okně Project Explorer vyvoláme 

kontextové menu. Z nabídky vybereme Insert -> UserForm. Zobrazí se prázdné dialogové okno, do 

kterého můžeme vkládat ovládací prvky (ListBox, CheckBox, OptionButton atd.) a měnit vlastnosti 

(viditelnost, název,barvu atd.). 
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i Microsoft Visual Basic - VbaProject.OTM - [VbaProject.OTM - UserForml (UserForm)] 
££j File Edit View Insert Format Debug Run Tools Add-Ins Window Help 
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- jgí Projectl (VbaProject.OTM) 
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U-H UserForml 
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Controls 
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UserForml UserForm 
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ŕľtarriŕ'l UserForml 
BackColor • &H8000000F& 
BorderColor • &H80000012& 
BorderStyle 0 - fmBorderStyleNone 
Caption Dialogové okno 
Cycle 0 - fmCycleAllForms 
DrawBuffer 32000 
Enabled True 
Font Tahonna 
ForeColor • &H80000012& 
Height 180 
HelpContextID o-
KeepScrollBarsVisible 3 - fmScrollEarsBoth 
Left y_ m 

Obr. 2.8 Dialogové okno 

2.2.3 Spouštění maker 

Nyní máme makra napsaná a zbývá nám je jen spustit. I zde existuje více možností, jak toho 

dosáhnout. První z nich je, zobrazit si veškerá makra a z nich si vybrat to, které potřebujeme. 

V případě, že máme napsáno velké množství maker, je tato metoda neefektivní. Zobrazí se nám totiž 

všechny napsané procedury, jejichž název je pevně daný, komplikovaný a nepřehledný. Pro zobrazení 

tohoto seznamu vybereme Tools->Macro->Macros... nebo pomocí Alt+F8. 

Macro Name: 
I riJBMBim 

ThisOutlookSession.InitializeJiandler 
ThisOutlook5ession.RunMyTaskForm 
Jh1ŠOutlóók5éssion.ShowForm 
ThisOutlook5ession.TaskForm 
ThisOutlookSession.WordDoc 

5tep Into 

Create 

Obr. 2.9 Seznam maker 

Jak je vidět na obrázku 2.8 je tato metoda velice nepřehledná, je proto vhodnější vytvořit si na Panelu 

nástrojů tlačítka a těmi následně spouštět makra. Vybereme Tools->Customize... v záložce Toolbars 

vytvoříme nový toolbar. Přepneme na záložku Commands, z nabídky Categories vybereme Macros. 
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Z nabídky Commands vybereme požadované makro a přetáhneme jej do vytvořeného toolbaru. Poté 

můžeme vyvolat kontextové menu, ve kterém můžeme změnit název nebo ikonu tlačítka. 

C Odeslat? C Task ß Word 

Toolbars 

To add a command to a toolbar: select a category and drag the 
command out of this dialog box to a toolbar. 
Categories: Commands: 
View 
Favorites 
Go 
Tools 
Actions 
Help 

Menu Bar 
Standard 
Advanced 

^ Projectl .ThisOutlookSession. Hello WorldM 

$b Projectl. ThisOutlookSession. Initialize_hai 

$b Projectl. ThisOutlookSession. RunMyTaskf 

Projectl. ThisOutlookSession. ShowForm 

^ Project 1. ThisOutlookSession. TaskForm 

$b Projectl. ThisOutlookSession. WordDoc 

[Modify Selection T~] | Rearrange Commands.. 

•j ProjertLThisOutlook£e5sjon.ShQwFcrm. I 
Reset 

Name: Projectl .ThisOutlo 

Copy Button Image 

Paste Button Image 

Reset Button Image 

Edit Button Image... 

Change Button Image • 

Default Style 

Text Only (Always) 

Text Only (in Menus) 

Image and Text 

Begin a Group 

Assign Hyperlink 

Obr. 2.10 Vytvoření toolbaru pro spouštění maker 

2.2.4 Bezpečnost 

Makra mohou využít útočníci k získání citlivých informací, jako jsou emaily, rozpisy 

schůzek, seznam kontaktů a osobních informací. Je proto nutné, sledovat jaká makra máme 

nainstalována a vždy si nové makra instalovat z důvěryhodných zdrojů. Máme také možnost nastavit 

úroveň zabezpečení přímo v Outlooku. Chceme-li změnit úroveň zabezpečení, zvolíme 

Tools->Macro->Security... Zde máme mimo jiné možnost vybrat z nabídky, zda makra úplně 

povolíme či úplně zakážeme. 
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3 COM add-in 

Hlavní výhodou C O M add-in je jejich snadná distribuce a ochrana napsaného kódu, což 

vyplývá z jejich podstaty D L L či E X E souboru. Tato vlastnost umožňuje psaní komerčních pluginů. 

Většinou se setkáme s D L L souborem, který je oproti E X E rychlejší. 

Existuje velké množství nástrojů pro tvorbu pluginů např.: Visual C++, Visual Basic,Visual 

Studio .NET, Visual Studio Tools for Office (VSTO). Z toho vyplývá i to, že vývoj aplikací se může 

provádět v různých programovacích jazycích, z nichž nejpoužívanější jsou C# a Visual Basic .NET. 

Pro vytváření C O M pluginů existují dvě odlišné architektury. První z nich se nazývá sdílené 

add-in (shared add-in), která je postavena na IDTExtensibility2 interface. Druhou možností jsou 

pluginy sestavené pomocí Visual Studio Tools for Office (VSTO). Tato architektura je dostupná pro 

verzi Outlook 2003 a novější Visual Studio Tools for Office vytváří podporu pro psaní kódu v jazyce 

Visual Basic .NET nebo C#. Jestliže porovnáme architekturu IDTExtensibility2 interface s VSTO, 

zjistíme, že VSTO nabízí několik výhod[3]: 

• lepší ladění již při návrhu 

• lepší odchytávání chyb za běhu programu 

• elegantní ukončení pluginů bez nutnosti spravovat všechny odkazy na C O M objekty 

• jednoduché události při spuštění a vypnutí programu 

• integrovaný designér pro formuláře a ribbon panel 

3.1 Spuštění D L L pluginů 

Nejdříve se podíváme na způsob, jak nainstalovat plugin. Jeho kód je uložen v D L L souboru 

a my teď musíme dát Outlooku vědět o jeho existenci. Všechny pluginy jsou registrovány v registrech 

Windows v následujícím umístění: 

HKEY_CURRENT_USER\Software\Microsoft\Office\Outlook\Addins\název 
V registru jsou také uloženy informace o názvu, popisu a umístění souboru s pluginem. Dále 

zde můžeme najít položku s názvem LoadBehavior, která určuje způsob načtení makra. V tabulce 3.1 

naleznete hodnoty s vysvětlením jejich významu. 
r  

Editor registru 
5oubor Úpravy Zobrazit Oblíbené položky Nápověda 

S- J É Outlook 
É-{J2ä Addins 

L j AccessAddin.DC 
: Colleaguelmport.Colle 

A Název Typ Data S- J É Outlook 
É-{J2ä Addins 

L j AccessAddin.DC 
: Colleaguelmport.Colle 

EJ"] (Výchozí) REG_SZ (Hodnota není zadána) 
Q Description REG_5Z EventHandler - Outlook add-in 
QFriendlyName REG_5Z EventHandler 
[BĴ LoadBehavior REG_DWORD 0x00000003 (3) 
[^Manifest REG_SZ C:\DocumentsandSettings\Ai: 

EJ"] (Výchozí) REG_SZ (Hodnota není zadána) 
Q Description REG_5Z EventHandler - Outlook add-in 
QFriendlyName REG_5Z EventHandler 
[BĴ LoadBehavior REG_DWORD 0x00000003 (3) 
[^Manifest REG_SZ C:\DocumentsandSettings\Ai: 1 UmOutlookAddin.Form 

+ _ | Word 

EJ"] (Výchozí) REG_SZ (Hodnota není zadána) 
Q Description REG_5Z EventHandler - Outlook add-in 
QFriendlyName REG_5Z EventHandler 
[BĴ LoadBehavior REG_DWORD 0x00000003 (3) 
[^Manifest REG_SZ C:\DocumentsandSettings\Ai: 

Obr. 3.1 Záznam pluginů v registru 
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Hodnota 
LoadBehavio 

r 

Stav 
pluginu 

Chování 
pluginu při 

spuštění 
Popis 

0 nenačten nenačítat 
automaticky 

Aplikace nenačítá plugin automaticky. Plugin může být 
načten uživatelem nebo programově. Pokud je plugin načten 
LoadBehavior zůstává na hodnotě 0, ale status pluginu 
v COM Add-in je aktualizován a ukazuje načtení. 

1 načten nenačítat 
automaticky 

Aplikace nenačítá plugin automaticky. Plugin může být 
načten uživatelem nebo programově. Přestože COM Add-in 
ukazuje, že plugin je načten po startu aplikace, ve skutečnosti 
načten není, až do okamžiku manuálního nebo programového 
načtení. Pokud je plugin načten, je LoadBehavior změněn na 
hodnotu 0 a zůstává tak i po ukončení aplikace. 

2 nenačten načíst při 
spuštění 

Aplikace se nepokouší načíst plugin automaticky. Plugin 
může být načten uživatelem nebo programově. Pokud je 
plugin načten LoadBehavior je změněn na hodnotu 3 a 
zůstává tak i po skončení aplikace. 

3 načten načíst při 
spuštění 

Aplikace se pokusí načíst plugin automaticky. Toto je 
základní hodnota po vytvoření pluginu ve Visual Stadiu. 
Pokud je plugin načten LoadBehavior zůstává hodnota 3. 
Pokud dojde při načítání k chybě LoadBehavior, je změněn na 
hodnoto 2 a zůstává tak i po skončení aplikace. 

8 nenačten načíst na 
vyžádání 

Aplikace se nepokouší načíst plugin automaticky. Plugin 
může být načten uživatelem nebo programově. Pokud je 
plugin načten, LoadBehavior je změněn na hodnotu 9. 

9 načten načíst na 
vyžádání 

Plugin je načten, pouze pokud je aplikací vyžadován. Pokud 
je plugin načten, LoadBehavior zůstává 9, ale status pluginu 
v COM Add-in je aktualizován a ukazuje načtení. Pokud 
dojde při načítání k chybě, LoadBehavior je změněn na 
hodnoto 8. 

16 načten 

načíst při 
prvním spuštění, 

poté načíst na 
vyžádání 

Při této hodnotě je plugin načten na vyžádání. Aplikace načte 
plugin při prvním spuštění. Při příštím spuštění aplikace načte 
veškeré uživatelské rozhraní pluginu, ale plugin není načten, 
dokud uživatel neaktivuje element z uživatelského rozhraní 
pluginu. Po úspěšném načtení zůstává LoadBehavior na 
hodnotě 16, dokud je plugin načten. Po skončení aplikace je 
LoadBehavior změněn na hodnotu 9. 

Tab. 3.1 Hodnoty LoadBehaviorv registru a jejich význam [4] 

3.2 Application-Specific Add-in 

Při psaní pluginu můžeme narazit na Application -Specific Add-in. Jedná se o pluginy určené 

přímo pro konkrétní program ze sady MS Office. Jestliže tedy napíšeme Application -Specific Add-

in, uložíme jej zvlášť pro Word a zvlášť pro Excel. I přestože mají oba pluginy velmi podobný kód, 

budou to dva samostatné pluginy. Při použití C O M Add-in však můžeme napsat jen jediný plugin, 

který bude obsahovat kód pro Word, kód pro Excel a kód sdílený pro oba programy. Pokud takový 

plugin registrujeme v registrech, bude použitelný pro oba programy [5], 
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Add-in Prípona souboru Použitelné pro 
Word add-in .dot, .wll, .wiz Pouze pro Word 
Excel add-in .xla, .xll Pouze pro Excel 

PowerPoint add-in .ppa, .pwz Pouze pro PowerPoint 
Access add-in .mda, .mde Pouze pro Access 

Exchange klient .dll Pouze pro Outlook a Microsoft Exchange 
klient 

C O M add-in .dll, .exe Word, Excel, PowerPoint, Outlook, Frontpage 
a další aplikace ze sady MS Office 

Tab. 3.2 Přípony pluginů a jejich použitelnost v aplikacích [5] 

3.3 Přehled Outlook object modelu 

Microsoft Office Outlook object model je založen na C O M (Component Object Model). 

Velké množství objektů z C O M je použitelných pro vývoj a úpravu Outlooku. V Outlook object 

modelu třída reprezentuje každý objekt z uživatelského rozhraní např.: 

M i c r o s o f t . O f f i c e . I n t e r o p . O u t l o o k . A p p l i c a t i o n reprezentuje celou aplikaci a třída 

M i c r o s o f t . O f f i c e . I n t e r o p . O u t l o o k . M a i l l t e m reprezentuje emailovou zprávu. 

Před samotným začátkem psaní pluginů je dobré seznámit se s některými základními objekty. 

A p p l i c a t i o n objekt reprezentuje aplikaci Outlook, jedná se o nejvyšší třídu v Outlook object 

modelu. E x p l o r e r koresponduje s oknem zobrazujícím složky a datové záznamy Outlooku jako 

např.: emaily, úkoly, schůzky atd. MAPIFolder reprezentuje složku obsahující emaily, kontakty, 

úkoly a další datové záznamy Outlooku. Je zde šestnáct základních MAPIFolder záznamů. 

I n s p e c t o r koresponduje s oknem zobrazujícím jeden záznam např.: jeden email nebo jeden 

kontakt[6]. 

3.4 Příklady 

Zabývat se budeme psaním pluginů architektury Visual Studio Tools for Office. Díky tomu 

můžeme psát pluginy pro šest aplikací z balíčku Microsoft Office. My však budeme psát pluginy 

pouze pro Outlook. Pro psaní kódu použijeme vývojové prostředí Microsoft Visual Studio 2008 

Professional Edition, jehož součástí je Microsoft Visual Studio 2008 Tools for Office, 

programovacím jezykem je C#. Pro spouštění a testování napsaných pluginů použijeme MS Outlook 

2007. Informace pro podkapitolu 3.4 jsem čerpal hlavně z [6] amsdn.microsoft.com. 
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3.4.1 První plugin „Hello World" 
Nyní můžeme začít s prvním pluginem. Spustíme Visual Studio a zvolíme File->New-

>Project... Vpravo z nabídky vybereme Visual C# -> Office -> 2007 a z nabídnutých šablon Outlook 

2007Add-in. Vymyslíme jméno projektu a určíme jeho umístění. 

.NET Framework 3.5 v L U D 
.Visual C# 

Windows 
j--Web 

Smart Device 
Q Office 

I- 2007 
2003 

• Database 
Reporting 

!-• Test 
|- WCF 
'•• Workflow 

+ Other Languages 
B•• Other Project Types 
©•Test Projects 

Visual Studio installed templates 

Excel 2ÜÜ7 Excel 2ÜÜ7 Excei 2007 
Add-in Template Workbook 

0 P 
InfoPath 2007 InfoPath 2007 

Add-in Form Template 

PowerPoint Project 2007 
^ ^ g ^ B 2007 Add-in Add-in 

nff 0 0 
Visio 2007 Word 2007 Word 2007 

Add-in Add-in DoeuftiehE" 

IM \M 
SharePoint SharePoint 
2007 5e... 2007 St... 

0 
Word 2007 
Template 

A project for creating a managed code add-in for Out[ook*£äi}3v (:NET Framework 3.5) 

Name: 

Location: 

Solution Name 

I Hello WorlcT 
C:\Documents and Setünb^Aidmn^ratcr^1öcha\BP\rny\C# 

Create directory for solution 

Obr. 3.2 Nový projekt 

Vytvoří se projekt střídou T h i s A d d l n a dvě procedury T h i s A d d I n _ S t a r t u p a 

ThisAddIn_Shutdown. Procedura T h i s A d d I n _ S t a r t u p je volána po startu aplikace, takže do 

ní vepíšeme náš pozdrav. 

System.Windows.Forms.MessageBox.Show("Hello W o r l d ! " ) ; 

První plugin je hotový, jeho funkce je jednoduchá, po spuštění Outlooku otevře dialogové okno 

s nápisem „Hello World!". 

3.4.2 Přidání menu 

Nyní se podíváme na daleko zajímavější téma. Při psaní pluginů, se určitě nevyhneme potřebě 

interakce s uživatelem. To se samozřejmě netýká jen rozsáhlých pluginů, ale i přidání třeba jen jedné 

funkce vyžaduje, aby měl uživatel možnost tuto funkci spustit. A v mnoha případech je právě přidání 

menu vhodným řešením. V Microsoft Office jsou všechny menu a toolbary CommandBars. 

CommandBar je kolekce obsahující standardní toolbary, menu, kontextová menu atd. Budeme 

pracovat s objektem E x p l o r e r . 
Při přidávání menu budeme provádět tyto kroky: 

• určíme, kam nové menu přidáme (v našem případě do hlavního menu) 

• vložíme nové menu do starého 
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• pojmenujeme menu 

• přidáme ovládací tlačítko a nastavíme obsluhu při kliknutí na něj. 

Při vytváření menu můžeme určit, zda chceme menu vpřidat trvale, či pouze dočasně. 

Dočasným přidáním se rozumí do konce běhu aplikace. V našem případě přidáváme menu trvale, 

poslední paramert ve funkci Add je nastaven na f a l s e . 
/ /def inujeme kam budeme p ř i d á v a t menu 
menuBar = t h i s . Appl i ca t ion . Act iveExplorer [) . CommandBars . ActivetlenuBar; 
/ / p ř i d á m e menu 
newMenuBar = (Of f i c e . CommandBarPopup) menuBar. Controls . Add ( 

Of f i ce . MsoControlType .msoControlPopup, miss ing , 
miss ing , miss ing , f a l s e ) ; 

i f (newMenuBar != nul l ) 
{ 

/ /nazev menu 
newMenuBar.Caption = "Nase menu"; 
newMenuBar . Tag = menuTag; 
/ / p r i d a n i t l a c i t k a do menu 
buttonOne = (Office.CommandBarButton)newMenuBar.Controls. 
Add[Office .MsoControlType.msoControlButton, miss ing , 

miss ing , 1, t rue ) ; 
/ / n a s t a v e n i t l a c i t k a 
buttonOne.Style = Off ice .MsoButtonStyle . 

msoButtonlconAndCaption; 
buttonOne.Caption = "Ahoj svete"; 
/ /nastavime ikonu t l a c i t k a 
buttonOne.Faceld = 610; 
buttonOne . Tag = "cl2 3"; 
/ / o b s l u h a p r i k l i k n u t i na t l a c i t k o 
buttonOne . C l i c k += new Of f ice ._CommandBarButtonEvents_ClickEventHandler [buttonOne_ClickII) ; 
newMenuBar.Visible = true; 

} 

Obr. 3.3 Kód přidání menu 

Když máme menu vytvořené jako trvalé, může nastat situace, kdy jej budeme chtít odstranit. 

K odstranění menu jej musíme nejdříve najít. Hledání provádíme pomocí popisu menu. 

Of f i ce . CommandBarPopup foundllenu = (Of f i c e . CommandBarPopup) 
t h i s . A p p l i c a t i o n . A c t i v e E x p l o r e r ( ) . C o m m a n d B a r s . A c t i v e M e n u B a r . 
F i n d C o n t r o l ( O f f i c e . M s o C o n t r o l T y p e . m s o C o n t r o l P o p u p , 
m i s s i n g , menuTag, t r u e , t r u e ) ; 

i f (foundMenu != n u l l ) 
{ 

foundMenu.Delete[true) ; 
> 

Obr.3.4 Kód odebrání menu 

Inbox - Microsoft Outlook: 

File Edit View Go Tools Actions Help Adobe PDF Nase menu \ 
lî New " |̂ ) l £ j X £jgepfy £J RepSy to-Ari LT̂ Forward % Ahoj svete (end/Receive -

Mail « Q Inbox 

Obr.3.5 Přidané menu 
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3.4.3 Úprava toolbaru 

Obdobně jako jsme pridali menu, můžeme přidat i toolbar. I v tomto případe budeme pracovat 

s E x p l o r e r objektem. Při vytváření budeme provádět tyto kroky: 

• nejdříve určíme, kam toolbar přidáme 

• vložíme nový toolbar mezi ostatní toolbary 

• pojmenujeme toolbar 

• přidáme ovládací tlačítko a nastavíme obsluhu při kliknutí na něj. 

too lBar = t h i s . App l i c a t i o n . Act iveExplorer [). CommandBars; 
/ / v y t v o ř e n i too lbaru 

newToolBar = t o o l B a r . A d d [ t o l I B a r T a g , Off ice .HsoBarPos i t ion .msoBarTop, f a l s e , true) ; 

/ / p ř i d á n i t l a c i t k a do too lbaru 

Office.CommandBarButton b u t t o n l = (Office.CommandBarButton) 
newToolBar .ControIs .Add[1 ,miss ing ,miss ing ,miss ing ,miss ing) ; 

/ / s t y l t l a c i t k a 
b u t t o n l . S t y l e = Off ice .MsoButtonStyle .msoButtonlconAndCaption; 
/ / p o p i s k y 
b u t t o n l . C a p t i o n = "Ahoj s v ě t e " ; 
b u t t o n l . T a g = buttonTag; 
/ / k o n t r o l a j e s t l i se povedlo t l a c i t k o vytvor i t j 
i f ( t h i s . b u t t o n O n e == nu l l ) 
{ 

/ / o b s l u h a k l i k n u t i na t l a c i t k o 
this .buttonOne = b u t t o n l ; 
but tonOne .Cl i ck += new Office._CommandBarButtonEvents_ClickEventHandler[buttonOne_ClickK); 

} 

Obr. 3.6 Kód přidáni toolbaru 

Inbox - Microsoft Outlook 

File Edit View Go Tools Actions Help Adobe PDF 

j ^ N e v u - l^l LQ X : ^ Reply Reply to All [^Forward " q Y Í 3 rä Send/Receive - U Search address boots - ® ň \ Ahoj svete _ : ß Odeslat? 

j Mail « 1 Í3 Inbox P H * [ |Ahoj svete 1 

Obr. 3.7 Pridaný toolbar 

Na rozdíl od nového menu nemusíme řešit odstranění toolbaru, protože při jeho vytváření 

jsme jej definovali jako dočasný. Poslední parametr přikazuje nastaven natrue. 

n e w T o o l B a r = t o o l B a r . A d d ( t o o l B a r T a g , O f f i c e . M s o B a r P o s i t i o n . m s o B a r T o p , 
falše,true) 

To znamená, že při každém vypnutí Outlooku se toolbar sám smaže. 

3.4.4 Form region 

Form region přichází s Outlookem 2007 a představují další možnost, jak vytvořit vlastní 

uživatelské rozhraní. Vytvoříme nový projekt a v Solution Exploreru vyvoláme kontextové menu. 
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Vybereme Add->New Item a z nabízených šablon zvolíme Outlook Form region. Tímto způsobem 

spustíme průvodce, který nám pomůže s tvorbou Form region. 

Add New Item - Form region 

S E 

E Visual C# Item? 
I - Code 
!•••• Data 

General 
!•- Web 
• Windows Forms 
! •• WPF 
! Office 
!•••• Reporting 
'' • Workflow 

Visual Studio installed templates 

Ribbon (Visual Ribbon (XML) About Box 
Designer) 

Application Application Asserfiblý 
Configurati... Manifest File Inforrnati... 

Bitmap File 

A class for creating an Outlook form region. 

FormRegionl .cs 

Obr. 3.8 Vytvoření Form region 

V prvním kroku vybereme možnost Design a new form region, dále vybíráme typ Form region, 

zvolíme Separete, tím přidáme novou stránku. Další možnosti jsou Adjoining (přidá naše úpravy na 

konec standardního formuláře), Replacement (nahradí základní stránku formuláře), Replace-all 

(nahradí všechny formuláře). Dalším krokem zvolíme název a také, kdy se námi vytvořený Form 

region bude zobrazovat. Můžeme jej zobrazit při vytváření položky nebo při čtení položky. Adjoining 

Form region, můžeme zobrazit vnáhledovém podokně Outlooku. Musíme vybrat alespoň jednu 

z uvedených možností. 

New Outlook Form Region 

Supply descriptive text and select your display preferences 

The name appears in the Ribbon of an Outlook item or as the header text in an adjoining form region. For the 
replacement and replace-all form region types, you can also include a title and description. 

What name, title, and description do you want to use? 

Name: 

FormRegion 

Description: 

In which display modes should this form region appear? 

[̂ 1 Inspectors that are in compose mode 

Rl Inspectors that are in read mode 

I | Reading Pane 

[ < Previous j [ Next > ^ Finish [ CanceT" 

Obr. 3.9 Průvodce vytvoření Form region 1 
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Posledním krokem vybereme, kde se bude náš Form region zobrazovat viz obrázek 3.10. 

New Outlook Form Region l_? I ® 

Identity the message classes that will display this form region 

You can associate the form region with standard or custom message classes. 

Which standard message classes will display this torm region? 

I I Appointment (IPM. Appointment) 

• Contact (IPM.Contact) 

• Distribution List (IPM.DistList) 

O Journal Entry (IPM.Activity) 

0 Mail Message (IPM.Note) 

• Post (IPM.Post) 

• RSS (IPM. Post. RSS) 

• Task (IPM.Task) 

To identify a custom message class, type the custom message class name (for example: IPM.Post.Contoso ). 
Separate multiple message class names with semicolons. 
Which custom message classes will display this torm region? 

< Previous I i Finish Cancel 

Obr. 3.10 Průvodce vytvoření Form region 2 

Abychom nenapsali jen prázdný Form region, vložíme do něj kód, který zobrazí odesílatele 

zprávy. Musíme se však ujistit, že skutečně pracujeme se zprávou, jestliže jsme při tvorbě Form 

region umožnili, aby se zobrazoval i v jiných položkách, než jen při tvorbě/čtení emailů. Také 

musíme ověřit, zda jsme v psacím nebo čtecím režimu. V psacím režimu zpráva z pohledu Outlooku 

odesílatele ještě nemá. 
private void FormRegionl_FormRegionShoTiring (object sender. System.EventArgs e) 
{ 

//overime j e s t l i pracujeme se správou 
i f (this.Outlookltem is Outlook.Mailltem) 
{ 

Outlook.Hailltem mail = (Out look.Hai1Item)this.Outlookltem; 
//overime j e s t l i existuje odesi latel zprávy 
i f (mail.SenderEmailAddress != null) 

listBoxl.Items.Add(mail.SenderEmailAddress); 
} 

} 

Obr. 3.11 Kód Form region 

/ C f e \ i ď "J O * -*- ? P o z d r a v - M e s s a g e (Plain Text) _ n x 

Message I Add-Ins Ado-be PE>F 

Í S 
Massage 

—J 
ForrnRegion 

t} Q Q 1 
Reply Reply Forward 

to All 

Delete Move to Create Other 
Foľder T Rule Actions- 1 , 

& Safe Lists -

Block L _ j Not Junk 
Sender 

B r a 
Categorize Fo l low Mark as 

U p - Unread 

3ft F ind 

^ Related -

Cj Select -

m 
Send to 

OneNote 
Show Respond Actions Junk E-mail r* Op t i ons tí. F i n d One Note 

mirek:f ájt@gmäil. com 

Obr. 3.12 Výsledný Form region 
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Obrázek 3.13 ukazuje, jak by vypadalo hlavní okno Outlooku, pokud bychom jako typ Form region 

zvolili Adjoining a zaškrtli zobrazování "Reading pane" v průvodci. 
lix Inbox - Microsoft Outlook 

: File Edit View Go lools Actions Help Adobe PDF 

l^jNevj ' |g) L£3 X ^ Reply ^ Re ply to AN ^ Forward Bfl T @ ijfi Send/Receive T kfcl Search address books T I ® ^ j f j Odeslat: E Task 

Mail << Q Inbox P '1 * Pozdrav 
B o h u m í r Fajt [mirek.fajt@gmail.com] 
Sent: ne 16.5,2010 4:07 
To: ja_34@centrurn.cz 

Ahoj 

5 pozdraveny 

Favorite Folders 
Inbox 

jj UmtGti Mail 
LJj Sent Items 

| Click here to enable Instant Search 
Pozdrav 
B o h u m í r Fajt [mirek.fajt@gmail.com] 
Sent: ne 16.5,2010 4:07 
To: ja_34@centrurn.cz 

Ahoj 

5 pozdraveny 

Favorite Folders 
Inbox 

jj UmtGti Mail 
LJj Sent Items 

Arranged By: Date Newest on top 

• Today 

Pozdrav 
B o h u m í r Fajt [mirek.fajt@gmail.com] 
Sent: ne 16.5,2010 4:07 
To: ja_34@centrurn.cz 

Ahoj 

5 pozdraveny 

Mail Folders A 

All Mail Items 
_j Bohumír Fajt 4:08 

Pozdrav 

Pozdrav 
B o h u m í r Fajt [mirek.fajt@gmail.com] 
Sent: ne 16.5,2010 4:07 
To: ja_34@centrurn.cz 

Ahoj 

5 pozdraveny 

• ^ Personal Folders 
§ Deleted Items P97] 

Drafts 
^Inbox 

£1 Older 

Pozdrav 
B o h u m í r Fajt [mirek.fajt@gmail.com] 
Sent: ne 16.5,2010 4:07 
To: ja_34@centrurn.cz 

Ahoj 

5 pozdraveny 

• ^ Personal Folders 
§ Deleted Items P97] 

Drafts 
^Inbox 

Nokia 27.1.3010 • 
NOKIA Xtour: přijďte se bavit a soutěžit do českých snowparkú! 

Pozdrav 
B o h u m í r Fajt [mirek.fajt@gmail.com] 
Sent: ne 16.5,2010 4:07 
To: ja_34@centrurn.cz 

Ahoj 

5 pozdraveny 

• Infected Items (4) 
Junk E-mail [434] 

@ Outbox 
L£J Feeds 
( § Sent Items 

ffl EJi Search Folders 

Mirek Fajt 24.11.2009 r | • 
Ahoj _ 

Bohumír Fa j t • Infected Items (4) 
Junk E-mail [434] 

@ Outbox 
L£J Feeds 
( § Sent Items 

ffl EJi Search Folders 

Q — FormRegion2  

1 rnirek.fajt@grTiail.com 

Obr. 3.13AdjoiningForm regiony hlavním okně Outlooku 

3.4.5 Kontextové menu 
Pomocí pluginu můžeme upravovat i kontextová menu. Následující ukázka přidá do 

kontextového menu jednu novou položku. Naše upravené kontextové menu se zobrazí, pokud jej 

vyvoláme nad nějakou záznamovou položkou Outlooku (email, kontakt atd.). Při přidávání položky 

do kontextového menu budeme postupně provádět tyto kroky: 

• inicializujeme obslužnou proceduru, ve které přidáme položku do kontextového menu, 

obslužná procedura bude reagovat na událost vzniklou vyvoláním kontextového menu 

nad položkou v Outlooku 

• v obslužné proceduře přidáme položku do kontextového menu 

• pojmenujeme novou položku 

• nastavíme j ej í popisky 
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private void ThisAddIn_Startup[obj ect sender, System.EventArgs e) 
{ 

/ / p r idani obsluhy udalosti vyvolani menu 
this.Application.ItemContextMenuDisplay += new Outlook. 

Appl icat ionEvents_ll_ItemContextHenuDisp layEventHandler (ObsKontextHenu) ; 
} 

void ObsKontextMenu (Of f ice . CommandBar commBar, Outlook. Selection Selection) 
{ 

Off ice.CommandBarPopup myItern = (Office.CommandBarPopup) 
commBar.Controls.Add(Office.HsoControlType.msoControlPopup, missing, "Mo je menu", 
commBar.Controls.Count + 1, missing); 

//vytvorime novou skupinu v menu 
myltem.BeginGroup = true; 
//nasev menu 
mylterťi. Tag = "myllenu"; 
/ /popis menu 
myltem.Caption = "Hoj e menu polozkal"; 
//zobraz ime vytvorene menu 
myltem.Visible = true; 

Obr. 3.14 Kód vytvoření kontextového menu 

Inbox - M i c r o s o f t Ou t l ook 

File Edit View Go T_ools Actions Help AdobePDF 

: j j N e w t X E^Reply ^ Reply to All ^Forward f ^ | Send/Receive 7 Qij Search addi 

M a i l « Q Inbox 
Favorite Folders. 1 Click here to enable Instant Search 

Inbox Inbox 
^rranged By: Date Newest on to 

p tjnreap MdH 
Sent Items £) Today 

Mail Folders. j j Bohumír Fajt 
Pozdrav 

4:03 
J2]ah Mail Items 

j j Bohumír Fajt 
Pozdrav Open 

Print B ^ Personal Folders 
!iS @ Deleted Items El Older 

Open 

Print 

E§| Drafts Nokia ei Reply 
G Inbox NOKIA Xtour: přijďte se bavit a s i Reply to All rt3 Nova slozka Reply to All 

Infected Items 
[j^ Junk E-mail [43S] 

Qutbox 

Forward Infected Items 
[j^ Junk E-mail [43S] 

Qutbox Follow Up • 

Ijjj RSS Feeds Categorize • 

E § Sent Items 
13 Search Folders 

S Outlook 2007 Programming Jumpstart 

a Mark as Unread E § Sent Items 
13 Search Folders 

S Outlook 2007 Programming Jumpstart Find All 

Create Rule... 

Junk E-mail 

• 

• 

ESETNQD32 Antivirus • 

X Delete 

Move to Folder... 

ú Message Options... 

Send to OneNote 

Moje menu polozkaL • 

Obr. 3.15 Kontextové menu 

3.4.6 Složky 
Pro lepší přehlednost příchozích emailů máme možnost, organizovat emaily do složek a 

podsložek. Jejich vytváření patří k základním dovednostem při psaní pluginů. Velmi často jsou 

pluginy psány právě proto, aby zpracovávaly příchozí poštu a třídily j i do složek. 
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3.4.6.1 Vytvoření složky 

Podíváme se jak takovou složku vytvořit. Při vytváření složky určíme, kde j i budeme vytvářet, 

její nadřazenou složku. 

Out look. NameSpace nameSpace = this . Appl icat ion. GetNaitiespace [ "HAPI") ; 
/ / u r č i m e kde budeme novou s l o ž k u v y t v á ř e t 
/ / v tomto pripade vytvorime podslozky do s l o ž k y Inbox 
Outlook.MAPIFolder folder = nanieSpace . GetDef aultFolder ( 

Microsoft .Off ice .Interop.Outlook.OlDefaultFolders .olFolderlntjox); 
/ /vytvorime novou s l o ž k u 
folder.Folders.Add("Nova s l o ž k a " , missing); 

Obr. 3.16 Kód vytvoření nové složky 

3.4.6.2 Přesun emailů 

V předchozím příkladu jsme si ukázali, jak vytvořit novou složku. Nyní se podíváme, jak 

manipulovat s emaily. V následujícím příkladu přesuneme všechny emaily ze složky Inbox do námi 

vytvořené složky. 

• určíme si složku, ze které budeme emaily přesouvat 

• vytvoříme složku, do které chceme emaily přesunout 

• přesuneme všechny emaily 

Outlook.NaitieSpace nameSpace = this . App l icat ion. GetNamespace ( "MAPI") ; 
/ / s l o ž k a ze k t e r é budeme přesouvat 
Outlook. MAPIFolder srcFolder = nameSpace . GetDef aultFolder ( 

Microsoft. Off ice. Interop. Outlook. OlDef aultFolder s .olFolderlnloox) ; 
/ / p o l o ž k y ve zdrojové s l o ž c e 
Outlook.Items items = (Outlook.Items)srcFolder.Items; 
Outlook.Mailltem mail = nul l ; 
/ / v y t v o ř e n i cilove s l o ž k y 
s r c F o l d e r . F o l d e r s . A d d ( " P ř e s u n o u t zde", missing); 
/ / c i l o v a s l o ž k a 
Outlook.MAPIFolder dstFoder = s r c F o l d e r . F o l d e r s [ " P ř e s u n o u t zde"]; 

foreach (object eMail in items) 
{ 

try 
{ 

mail = eMail as Out look.Mai 1Item; 
i f (mail != null) 
{ 

mail.Move[dstFoder) ; 
} 

> 

catch (Exception ex) 
{ 

System.Windows.Forms.MessageBox.Show(ex.Message); 
} 

} 

Obr. 3.17 Kód přesunu emailů 
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[L^ P resunout z d e - M i c r o s o f t Ou t l ook 

File Edit View Go Tools Actions Help Adobe PDF 

j ^ N e w - X t ^ R e p l y Reply to All ^ F o r w a r d "a T" ^Send/Rece i ve - |kl Search address books " ' ® ^ i 0 Odeslat? f^Task 
Mail « 
Favorite Folders ft 

Přesunout z... P H * 

Click, here to enable Instant Search. 
Pozdrav 
B o h u m í r Fa j t [ m i r e k . f a j t @ g m a i l . c o m ] 

Sent: ne 16.5,2010 4:07 
To: ja_B4Scentrum.cT 

A h o j 

S p o z d r a v e m , 

J Inbox 

Lj3 Sent Items 

Arranged By. Date Newest on top 

Pozdrav 
B o h u m í r Fa j t [ m i r e k . f a j t @ g m a i l . c o m ] 

Sent: ne 16.5,2010 4:07 
To: ja_B4Scentrum.cT 

A h o j 

S p o z d r a v e m , 

Mail Fo 1 ders ft 

,p] Al l Mai l Items 

Ql Bohumír Fajt 4:0S 
Pozd rav 

Pozdrav 
B o h u m í r Fa j t [ m i r e k . f a j t @ g m a i l . c o m ] 

Sent: ne 16.5,2010 4:07 
To: ja_B4Scentrum.cT 

A h o j 

S p o z d r a v e m , 

•d ̂  personal Folders 
i3 © Deleted Items 

Ejg] Drafts 
13 Inbox 

13 01 der 

Pozdrav 
B o h u m í r Fa j t [ m i r e k . f a j t @ g m a i l . c o m ] 

Sent: ne 16.5,2010 4:07 
To: ja_B4Scentrum.cT 

A h o j 

S p o z d r a v e m , 

•d ̂  personal Folders 
i3 © Deleted Items 

Ejg] Drafts 
13 Inbox 

Qi Nokia 211.201(1 
NOKIA Xtour: prijtřte se bavit a soutěžit do českých snowparkú! 

Pozdrav 
B o h u m í r Fa j t [ m i r e k . f a j t @ g m a i l . c o m ] 

Sent: ne 16.5,2010 4:07 
To: ja_B4Scentrum.cT 

A h o j 

S p o z d r a v e m , 

r~i Nova složka 
f"~i Přesunout zde 

Mirek Fajt 24.ii.200B — 
Ahoj 

B o h u m í r F a j t 

I n f o r m a t i o n f r o m E S E T NOC 
t~2 Infected Items 

Junk E-maiF [437] 

Obr. 3.18 Přesunuté emaily 

B o h u m í r F a j t 

I n f o r m a t i o n f r o m E S E T NOC 

3.4.6.3 Smazání složky 

Zbývá už je vytvořené složky smazat. Při odstraňování bychom měli zkontrolovat, zda ve 

složce nezůstaly zprávy, které smazat nechceme. Odstraníme totiž nejen složku, ale i celý její obsah. 

Odstraňovanou složku můžeme určit indexem (indexování složek začíná od 1) jako v ukázce nebo 

použít název složky: f o l d e r . F o l d e r s ["nazevMazaneSlozky"] . D e l e t e () 
V následujícím příkladu budeme mazat druhou podsložku složky Inbox. 

• najdeme nadřazenou složku složky, kterou chceme smazat 

• odstraňovanou složku určíme jejím indexem 

Outlook.NameSpace nameSpace = this.Application.GetNamespace("MAPI"); 
/ / u r č i m e kde budeme mazat 
Outlook.MAPIFolder folder = nameSpace.GetDefaultFolder( 

Microsoft.Office.Interop.Outlook.OlDefaultFolders.olFolderlnbox); 
//vytvoriitie smazem druhou p o d s l o ž k u ve s l o ž c e Inbox 
folder.Folders[2] .Delete(); 

Obr. 3.19 Kód odstranění složky 

3.4.7 Kontakty 

Kontakty obsahují velké množství nejrůznějších informací (jméno, příjmení, email, telefonní 

spojení, adresu atd.) o osobách, se kterými komunikujeme. Není proto divu, že velmi často 

potřebujeme měnit tyto informace dynamicky, a právě s tímto problémem nám pomůže VSTO plugin. 

3.4.7.1 Vytvoření kontaktu 

Předvedeme si, jak jednoduše vytvořit kontakt: 

• vytvoříme nový kontakt 

• vložíme údaje, které chceme uložit 

• uložíme kontakt 
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/ /Vytvorime novy kontakt 
Outlook.Contact Item neuContact = (Outlook.ContactItem) 

this .Applicat ion.CreateItem(Outlook.QlItemType.olContactItem); 
//sadame jmeno 
neuContact.FirstName = "Bohumir"; 
/ / z a d á m e prijmeni 
neuContact.LastName = "Fajt"; 
//sadame email 
neuContact. Ha i 1 ingAddress = "xf a j tbOOGstud. f i t . v u t b r . cs"; 
/ / z a d á m e skupinu 
neuContact.Categories = "VUT"; 
/ /ulos ime kontakt 
neuContact.Save(); 

Obr. 3.20 Kód vytvoření nového kontaktu 

£ C o n t a c t s - M i c r o s o f t O u t l o o k 

: File Edit V i ew Go Tools Act ions Help Adobe PDF 

J S i N e w T í f t [ g X Q - % r m U l i Search address books T 1 @ g 

Contacts « ! i Contacts 
A l l Contac t Items | Click here to enable Instant Search 

M y Contacts & 
Fait. Bohumir 

Contacts 

Current V i ew 
B o h u m i r F a j t 

•0 Business Cards 

O Address Cards 

O Detailed Address Cards 

O Phone List 

O By Category 

O By Com-pany 

xfajUjOOSstud.fit.vutbľ.r.1 

Obr. 3.21 Vytvořený kontakt 

3.4.7.2 Skupina kontaktů 

Jednou z nej důležitější ch funkcí Outlooku, co se týče správy kontaktů, je vytváření skupin 

kontaktů. Jedná se o rychlou a efektivní cestu, jak rozeslat hromadný email určité skupině lidí. 

Skupina obsahuje seznam kontaktů a jejich emailových adres, kterým můžeme posílat emaily. 

• vytvoříme skupinu 

• pojmenujeme skupinu 

• vytvoříme nový email, ten však nebudeme ukládat ani odesílat 

• do emailu vložíme příjemce (jméno, emailová adresa) 

• příjemce z emailu vložíme do skupiny 

• uložíme skupinu 
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/ / v y t v o ř e n i skupiny prijeincu 
Outlook. DistList l tern group = (Outlook. DistListltern) 

th is . Appl i ca t ion . Create Item (Outlook. OlItemType . o l D i s t r ilout ionLis t Item) . 
/ / z a d á m e nasev skupiny 
group. DLNaine = "Hoje skupina"; 
Outlook. Mailltem mail = (Outlook.MailItem) 

this .Appl icat ion.CreateItem(Outlook.OlItemType.olHai l l tem); 
//seznam p ř í j e m c ů 
mai l . Recipients . Add ( "Bohumír Faj t <xf a_ tlnOOGstud. í i t . vutb.r . cz>"rr) ; 
mail .Recipients .Add("Jan Novak <novak@seznam.cz>"); 
/ / p ř i d a n í seznamu prijeincu do skupiny 
group . AddHeiribers (mail. Recipients) ; 
/ / u l o ž e n i skupiny 
group.Save() ; 

Obr. 3.22 Kód vytvoření skupiny kontaktů 

Ĺ.--, Contacts - Microsof t Outlook 

: File Edit View Go Tools Actions Help Adobe PDF 

|_lMew- ,J_yL_5X'^^_--__'f' _ _ Search address books 

Contacts 

__ All Contact Items 

My Contacts 
_J Contacts 

H Contacts; 

e to enable Instant dearth 

Current View 
© Business Cards 
O Address Cards 
O Detailed Address Cards 
O Phone List 
O Ely Category 
O Ely Company 

Bohumil* Fajt 

xfajtborjigstLid.fit.vutjr.( 

1 laje skupina 

Moje skupina Moje skupina 

Obr. 3.23 Vytvořená skupina 

3.4.8 Emailové zprávy 

3.4.8.1 Vytvoření nové zprávy 

MS Outlook je v první řadě emailový klient a jeho hlavním úkolem je přijímání, odesílání 

zpráv a jejich správa. Nyní si tedy ukážeme, jak takovou zprávu vytvořit. Emailovou zprávu 

reprezentuje třída M i c r o s o f t . O f f i c e . I n t e r o p . O u t l o o k . M a i l l t e m 

• vytvoříme nový email 

• vložíme potřebné údaje (příjemce, předmět, tělo, důležitost emailu atd.) 

• email buď rovnou odešleme nebo jej můžeme zobrazit uživateli pro editaci 

/ /vytvor ime novou z p r á v u 
Outlook:. H a i l Item newHail = [Outlook. Hal litem) 

t h i s . A p p l i c a t i o n . C r e a t e Item(Outlook.OlItemType•olHail l tem); 
/ / v loz ime prijemcovu emailovou adresu 
newHail.To = "xf aj tbOO@stud. f i t . vutbr . c z"; 
/ / v loz ime predmet 
newHail .Subject = "Pozdrav"; 
/ / v loz ime obsah zprBvy 
newHail.Body = "Dobry den."; 
/ / d a l e muzeme nastav i t treba d ů l e ž i t o s t z p r á v y 
newHail. Importance = Out look:. Ol Importance . olImportanceNormal; 
/ / j e s t l i ž e chceme napsanou z p r á v u dale upravovat rucne zobrazime j i 
newHai l .Disp lay( true) ; 
/ / j e s t l i ž e chceme z p r á v u rovnou odeslet p o u ž i j e m e n a s l e d u j i c i pr ikaz 
/ / n e w H a i l . Send () ; 

Obr. 3.24 Vytvoření nové zprávy 
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3.4.8.2 Kategorizace zpráv 

Při větším množství zpráv se může stát orientace v nich velmi složitou, zprávy tak můžeme 

organizovat nejen do složek, ale můžeme je i barevně označit a přiřadit jim kategorii. Označit zprávu 

můžeme ručně nebo také programově. Následující příklad vytvoří kategorii a přiřadí j i první zprávě 

ze složky Inbox. 

• určíme zprávu, kterou chceme označit. V našem případě první zprávu ze složky Inbox 

• přiřadíme zprávě kategorii 

• uložíme změny 
Outlook.NameSpace nameSpace = this.Application.GetNamespace("HAPI"); 
Outlook.MAPIFolder srcFolder = nameSpace.GetDefaultFolder( 

Microsoft. Office. Interop. Outlook. OlTjef aul t Folders .olFolderlnbox) ; 
Outlook.Items items = (Outlook.Items)srcFolder.Items; 

Outlook.Hailltem mail = (Outlook.Hailltem) items . GetLast () ; 
mail.Categories = "Kategorie1"; 
mail.Save(); 

Obr. 3.25 Kód vytvoření kategorie 

• r Í U T \ i d *) O * " * * P o z d r a v - M e 5 s a g e (Plain Text) _ n X 

— ' M e n a g e | Add-Ins Adobe PDF @ 

; ují -4 
Reply Reply Forward 

to All 
Delete Move to Create Other 

F o l d e r T Rule A c t i o n s T 

& & Safe Lists -

Block ^ r j o t Junl 
Sender 

J H r ^ 
Categorize Fol lo iv Mark as 

U p " Unread 

._t_ Find 

^f , Related -

L£ S e l e c t ' 

p 
Send to 

OneNote 
Respond Actions Junk E-mail !3 Opt ions Find OneNote 

1 Kategor ie l 

From: Bohumír Fajt [mirek.fajt#grnail,corn] 
To: ja_34@centrum.cz 
Cc: 
Subject: Pozdrav 

Sent: ne l6 .5 .2010 4:07 

rtu; 

n 
Obr. 3.26 Označení zprávy vytvořenou kategorií 

Nebo můžeme nechat uživatele, ať kategorii zvolí ručně. 

• najdeme první zprávu ze složky Inbox 

• vyvoláme nabídku, ve které uživatel zvolí kategorii 

Out look.NameSpace namespace = this .Application.GetNamespace("HAPI"); 
Outlook.HAPIFolder srcFolder = namespace.GetDefaultFolder( 

Ilicrosof t . Of i ice . Interop . Out look .01Defaul tFolders .o lFo lder Inbox) i 
Outlook.Items items = (Outlook.Items)srcFolder.Items; 

Out look .Hai l l tem mai l = (Out look.Hai l l tem)i tems.GetLast ( ) ; 
mail .ShowCategoriesDialog(); 

Obr. 3.27 Kód vyvolání menu s nabídkou kategorií 
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•:atego: v To edit a catpgorVj seient ihr. rategory name ̂ nd thf commands to the right 

Name Shortcut key [ «... 1 • Q Blue Category 
0 Q jGreen Category: S p o z d r a v e m . 

• Q Blue Category 
0 Q jGreen Category: | Rename j S p o z d r a v e m . 

• Q Blue Category 
0 Q jGreen Category: S p o z d r a v e m . 
0 Q Kategoriel (not in Master Category List) 
|~~| Q Orange Category 
[~| Q Purple Category 
• __ Ped Category 
[~| Q Yellow Category 

Delete j 
Bohumír F a j t 

0 Q Kategoriel (not in Master Category List) 
|~~| Q Orange Category 
[~| Q Purple Category 
• __ Ped Category 
[~| Q Yellow Category 

Color: 

0 Q Kategoriel (not in Master Category List) 
|~~| Q Orange Category 
[~| Q Purple Category 
• __ Ped Category 
[~| Q Yellow Category 

[a i 
I n f o r m a t i o n f r i 

0 Q Kategoriel (not in Master Category List) 
|~~| Q Orange Category 
[~| Q Purple Category 
• __ Ped Category 
[~| Q Yellow Category Shortcut Key: 

f 2 0 1 0 0 3 1 S ) 

0 Q Kategoriel (not in Master Category List) 
|~~| Q Orange Category 
[~| Q Purple Category 
• __ Ped Category 
[~| Q Yellow Category 

(None) 9 

The message was c h e c k e d b; 

h t t p : / / L i i i L - j . e s e - . i o r i 

1 OK 
| Cancel j 

Obr. 3.28 Vyvolání nabídky pro zvolení kategorie 

3.4.9 Kalendář 

Komponenta kalendář v MS Outlooku nám pomáhá organizovat náš čas. Tato komponenta je 

plně integrovaná, takže nám umožňuje spolupracovat s dalšími komponentami, jako jsou emaily či 

kontakty. 

3.4.9.1 Nový záznam v kalendáři 

Při vytváření záznamu do kalendáře máme možnost nastavit velké množství doplňkových 

informací, které nám pomohou ve snadnější orientaci a organizaci záznamů např.: důvod schůzky, 

podrobnější popis, důležitost, opakování, upozornění před schůzkou atd. Záznamu můžeme také 

přiřadit kategorii, jako v případě emailu. Jak vytvořit záznam do kalendáře: 

• vytvoříme záznam 

• vložíme předmět, místo 

• vepíšeme podrobnější popis 

• určíme začátek a konec 

• nastavíme důležitost 

• uložíme do kalendáře 

Outlook.Appointment Item appoint = (Outlook.Appointment Item) 
this.Application.Createltem(Outlook.OlItemType.o 1AppointmentItem) ; 

appoint. Subject = "Subar"; 
appoint.Location = "Brno"; 
appoint.Body = "Providelna prohlidka"; 
appoint.Start = new DateTirae(2010, S, 17, 13, 1, 2); 
appoint.End = new DateTime(2010,5,17,14,1,2); 
appoint.Importance = Outlook.Ollmportance.olImportanceHigh; 
appo int.Save() ; 

Obr. 3.29 Kód vytvoření nové schůzky 
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ä o * » 5 Zubař - Appoíntr 

v 1 
Appointment Insert Format Text • j ^Calendar 

™ X Delate 
Save Si Invite 
Close Attendees Forwaiu" * 

Appointment Scheduling 
B ™ H Busy -i o d s y , ^ p , i " t e 

V-^ ^5 _IU j H ioh Importance 
i> Reminden 15 minutes - Recurrence Time Categorize' 

Zones t ^ Low Importance actions Show Options r* 

Subject: Zubař 

Location: Brno 

Start time: | po 17.5.2010 v | 113-01 v • All day event 
End time: | po 17.5.2010 v-| 114101 v | 

Prrjvidefna prohlídka 

Obr. 3.30 Vytvořená nová schůzka 

3.4.9.2 Odstranění záznamu z kalendáře 

Při odstraňování záznamu z kalendáře je postup podobný jako při mazání složky: 

• vstoupíme do složky kalendáře 

• vybereme datové záznamy 

• najdeme odstraňovanou složku pomocí předmětu 

• smažeme položku 

/ / n a č t e m e s l o ž k u se zaznami z k a l e n d á r e 
Outlook. MAPIFolder ca lFolder = A p p l i c a t i o n . Session. 

GetDef aultFolderr (Outlook. OlDef a u l t F o l d e r s . olFoldecCalendair) ; 
/ / z í s k a m e d a t o v é záznamy ze s l o ž k y 
Outlook. Items item = calFolder .I tems; 
/ / v y h l e d á m e záznam podle predmetu 

Outlook.Appointmentltem cal l tem - i t e m [ " Z u b a ř " ] as 
Outlook.Appo intmentItem; 

calltem.De l e t e [ ) ; 

Obr. 3.31 Kód smazání záznamu v kalendáři 

3.4.9.3 Práce s meetingy 

Další užitečnou funkci, kterou kalendář Outlooku nabízí, je plánování meetingů. Jedná se 

v podstatě o stejný druh záznamu jako v předchozím případě, pouze s tím rozdílem, že do záznamu 

můžeme vložit účastníky a odeslat jim emailem oznámení. 

• vytvoříme záznam kalendáře 

• označíme j ej j ako meeting 

• vyplníme údaje (předmět, tělo, místo, začátek, konec atd.) 

• přidáme účastníky 

• určíme, zdaje účastník na meetingu vyžadován nebo je jeho účast volitelná 

• uložíme záznam 
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Outlook.AppointmentItem meeting = (Outlook.Appointmentltem) 
this.Application.CreateItem[Outlook.OlItemType.olAppointmentltem); 

/ /o z n a č e n i záznamu j ako meeting 
meet ing.Meet ingStatus = Outlook.OlMeet ingStatus.olHeet ing; 
/ /vyplneni udaju 
meet ing.Subj ect = "Financni pIan"; 
meet ing.Body = "Financni plan na pr i s t i č t v r t l é t i " ; 
meet ing.Locat ion = "Brno"; 
meeting.Start = new DateTime(2010, 5, 17, 14, 0, 0); 
meeting.End = new DateTime(2•10, 5, 17, 15, 0, • ) ; 
/ / p r idani ú č a s t n í k u 
Outlook.Recipient ucastnik = meeting.Recipients.Add("xfajtb00@stud.fit .vutbr.cz"); 
Outlook.Recipient- u c a s t n i k £ = meeting.Recipients.Add("novak@seznam.cz"); 
ucastnik.Type = (int)Outlook.OlHeetingRecipientType.olRequired; 
ucastnik2.Type = [int)Outlook.OlHeetingRecipientType.olOptional; 
//muzeme zobrazit meeting pro d a l i s i ed i tac i u ž i v a t e l e m 
/ /meeting.Display[true); 
/ / u l o ž e n i meetingu 
meeting.Save[); 

Obr. 3.32 Kód vytvoření meetingu 

— * í I Meeting <^i!il řL JLTW.l 

•^Ca lendar 

Cancel . ^ F o r w a r d • 
Meeting 

actions 

p p o i ntm e nt Scheduling Tracking Add or Remove Message to Meeting 
Attendees Attendees T Workspace 

Show Attendees 

No responses have been received for this meeting. 

S 3 
Send 

Update 

[ To,,, j xfaitbOO@stud,fit,vutbr,cz: novakiSseznarn.i 

Subject: ^inancni plan 

Location: Brno 

Starttime: i po 17,5,2010 14 00 

End time: |po 17,5,2010 15:00 

v • All day event 

Finanční ptan na pristi čtvrtletí 

Obr. 3.33 Vytvořený meeting 

3.4.10 Ribbon menu 

Se sadou Office 2007 přichází nový způsob organizování nástrojů pro práci s aplikací. 

Ribbon menu se snaží nabídnout uživateli přehlednější způsob organizování nástrojů jako změna 

velikosti písma, změna fontu, vkládání obrázků, vytváření grafů, vkládání vzorců a spoustu dalšího. 

Ribbon menu je dostupné ve většině aplikací ze sady Office 2007 (Word, Excel, Outlook...). InfoPath 

a Visio jej ale nepodporují. 

Vytvoříme nový projekt a v Solution Exploreru vyvoláme kontextové menu. Vybereme 

Add->New Item a z nabízených možností vybereme Ribbon (visual designér). Otevře se nám 

návrhové okno s podobou budoucího Ribbon menu. Zde můžeme měnit podobu budoucího menu a 

jeho vlastnosti, popisy a podobně. 
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• q 3 3 » a a-,. 

1 n 

Zde vybíráme ovládací prvky do Ribbon 
menu 

Zde 
měníme 
vlastnosti 
prvku 

Slili M ' -i  

! 

Obr. 3.34 Návrh Ribbon menu 

Dalším krokem je určit, kde se námi vytvářené menu bude zobrazovat. V návrhu vybereme celé menu 

a v jeho vlastnostech rozvineme položku RibbonType a zaškrtneme položky, kde chceme zobrazit 

naše menu. 

Debug Data Tools Test Window Properties 

Ä i ť Debug 
Ribbon 1 Microsoft. Off ice. Tools. Ribbon. Off iceRibbon 

Ribbonl.cs [Design] Ribbon 1.Design El (Application5ettings) 
(Name) Ribbon 1 
Language (Default) 

•'PT^ Rib b oni Localizable False 

1 ZaJozka [Built-in) | P ihhrinTwriťi 
False 
Mice osoft.Out loo k.Mail.Re3cl 

Novy kontakt 

moje skupina 

StartFrornScratch ! Microsoft .Excel.Workbook Novy kontakt 

moje skupina 

Tabs Microsoft. Outlook. Appointment 
Novy kontakt 

moje skupina 

Tag | | Microsoft.Outlook,Contact 

Novy kontakt 

moje skupina 

Microsoft .Outlook. DistributionList 
| | Microsoft.Outlook.Journal 
|~1 Microsoft.Outlook.Mail,Compose 
0 Microsoft.Outlook.Mail.Read 

Microsoft .Outlook. MeetingRequest. Read 
Microsoft.Outlook. MeetingRequest.Send 

| | Microsoft.Outlook.Post.Compose 
• Microsoft.Outlook.Post.Read 

Obr. 3.35 Zobrazeni Ribbon Menu 

Na závěr vytvoříme činnost našemu menu. Při psaní emailu kliknutím na tlačítko otevřeme 

dialog pro vytvoření nového kontaktu. Do skupiny vložíme tlačítko a provedeme na něm dvoj klik. 

Vytvoří se nám obslužná procedura pro kliknutí na dané tlačítko. 

O u t l o o k . A p p l i c a t i o n C l a s s app = new O u t l o o k . A p p l i c a t i o n C l a s s ( ) ; 
Outlook.NameSpace nameSpace = app.GetNamespace("HAPI") ; 
Outlook.HAPIFolder mapiFolder = nameSpace.GetDefaultFolder( 

O u t l o o k . O l D e f a u l t F o l d e r s . o l F o l d e r C o n t a c t s ) ; 
Outlook.Contactltem newContact =. (Outlook.Contactltem) 

mapiFolder . Iteitis . Add (Outlook. OlItemType . olContactItem) ; 
neuContacc.Display(true) ; 

Obr. 3.36 Kód obslužné procedury tlačítka 

29 



/ ť h V H *> * + * 
Message Záložka A d o b e PDF 

ESET NOD32 Antiv irus - Q Novy kontakt 

Custom Toolbars moje skup ina 

Green Category 

From: 
To: 
Cc: 
Subject: 

Bohumír Farjt [mirek, fajt@!gmail, com] 
ja_34<aľcentrurn. cľ 

Pozdrav 

Ahoj 

Obr. 3.37 Vytvořené Ribbon menu 

3.4.11 Obsluha událostí 

Outlooku za svého běhu generuje velkou spoustu událostí, tyto události můžeme odchytávat a 

napsáním vlastní obslužné procedury na ně reagovat. 

Ukážeme si, jak to vypadá v praxi. Odchytávanou událostí je ItemSend. Tato událost je 

vyvolána poté co uživatel klikne na tlačítko Odeslat, ale ještš před odesláním emailu. V následujícím 

příklad odchytí událost ItemSend a pokud uživatel odesílá email bez vyplněného předmětu, zeptá 

se jej, jestli chce takový email odeslat. 

Jako první nastavíme obslužnou proceduru pro událost ItemSend. 

/ / N a s t a v e n i o b s l u ž n é procedury pro u d á l o s t ItemSend 
t h i s . A p p l i c a t i o n . I t e m S e n d += new 

Outlook. A p p l i c a t i o n E v e n t s 11 IterciSendEventHandler [Obsluha ItemSend); 

Obr. 3.38 Kód nastavení obslužné procedury 

V obslužné proceduře zjistíme, jestli má odesílaný email vyplněný předmět. Jestliže ne, 

zeptáme se uživatele, zda chce i přesto email odeslat. 
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v o i d Obsluha_ItemSend (ob j ec t itern, ref bool cancel) 
( 

/ / s p r a v a , k t e r á v y v o l a l a u d á l o s t 
Out look .Mai l l t em mai l = item as Out look .Ha i l i t em; 
s t r i n g o t á z k a = "Opravdu c h c e š odeslat email bez predmetu?"; 
s t r i n g popis = "Odeslat?"; 
DialogResult v y s l ; 
IlessageBoxEuttons t l a c = IlessageBoxButtons. YesNo; 

i f (mai 1. Sub j ect == nul l ) 
( 

/ / d o t a z j e s t l i chce u ž i v a t e l odeslat 
v y s l = HessageBox.Show(otaska, popis , 
/ /vyhodnoceni v ý s l e d k u dotazu 
i f (vysl == DialogResult .No) 

cancel = true; 

í 
} 

Obr. 3.39 Kód obslužné události ItemSend 

3.4.12 Komplexní ukázka 

Nyní si ukážeme plugin spojující několik předchozích podkapitol. Plugin vytvoří nové menu 

s jedním tlačítkem. Po jeho aktivaci se zobrazí dialogové okno, ve kterém doplníme jméno, příjmení, 

číslo objednávky a email. V dialogovém okně bude také tlačítko Send, na které kliknutím vytvoříme 

emailovou zprávu, obsahující údaje z dialogového okna. Dále bude plugin odchytávat událost 

ItemSend. Po jejím příchodu zavře dialogové okno. 

• nastavíme obslužnou proceduru pro událost ItemSend viz kapitola 3.4.11 

• vytvoříme menu viz kapitola 3.4.2 

• vytvoříme dialogové okno (v Project Exploreru vyvoláme kontextové menu a zvolíme 

Add->New Item... ze šablon zvolíme Windows Form) 

• navrhneme grafickou podobu dialogového okna 

• napíšeme obslužný kód, vyvolaný kliknutím na tlačítko v dialogovém okně 

_ 3 Inbox - M ic roso f t Out look 

File Edit View Go Tools Actions Help Adobe PDF Potvrzeni J 

i i J t jNew T l§] D^Repfy Reply to A] I ^ F o r w a r d .-gjt Odesláni zásilky 

Obr. 3.40 Vytvořené menu 

B Poivrze ni o des La ni [_] [ft] [x] 

Name |B°humír  

Surname l̂ "aî  

email nfajlbO0@slud.fil vi 

Send 

Obr. 3.41 Navržené dialogové okno 

z p r á v u i bez predmetu 
t l a c ) ; 
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#region Buttonl Event 
private void buttonl_C1ick(object sender. EventArgs e) 
! 

SendEmail(textBoxl.Text, textBoxZ.Text, textBox3.Text, textBox4.Text); 

I 
#endregion 

#region o d e s l á n i emailu 
private void SendEmail (string name, string sourname, string cObj, string email) 
{ 

string body; 
/ / s l o ž e n i te la zpr|avy 
body = "Vaseny pane < S TRONG> k name % < / S TRONG> <STRONG>%sourname%</STRONG>, <BR /> Vase ol 
StringBuilder sb = new StringBuilder(body); 
sb . Rep lace ( "%name% ", name . ToStr ing () ) ; 
sb . Rep lace ( "%sourname% ", sour name . ToStr ing () ) ; 
sb . Rep lace (rr%cOb j% ", cOb j .ToStr ing () ) ; 

Outlook.Application appl = new Microsoft.Office.Interop.Outlook.Application() ; 
Outlook.HailItem mail l = (Outlook.HailItem) 

appl.Create Item(Microsoft.Office.Interop.Outlook.OlItemType.olKailltern) ; 
mai11.To = emai1; 
mai 11. Sub ject = ("Objednávka c i s lo : " -I- cObj+" byla odes laná") ; 
maill.BodyFormat = Microsoft.Office.Interop.Outlook.OlBodyFormat.olFormatHTML; 
maill.HTMLBody = sb.ToString(); 
mail l .Display(true); 

Í 

Obr. 3.42 Kód pro tlačítko v dialogovém okně 

Objednávka cislo: Q0Q1 byla odeslaná - Message (HTML) 

Me5sage . Insert Op t i ons Format Text A d o b e PDF 

ý Format Painter 

C l i pboa rd r * 

B i n l l^j - ^ ~-||== m m\\ 
Basic Text  

Address Check Attach Attach Bus iness Ca lendar S igna tu re 
B o c k Names File item C a r d -

Wanies 11 M / d * . * 

Tc... • • V - > - : L - : : ^ ; ^ . . - . : - : . . " - ^ : - . C I 

subject : Objednávka cislo: 0001 byla odeslaná 

Vazeny pane Bohumír Fajt 
V i s e objednávka c.obj: 0001 byla.pra.ve odeslaná na. Vasi adreesu 

Dekujeme za duveru. 
www.obch.od.cz 

Obr. 3.43 Výsledný email 
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4 Závěr 

Cílem mojí bakalářské práce bylo, projít si možnosti psaní rozšíření pro MS Outlook a 

demonstrovat je na příkladech. Ukázal jsem dva možné způsoby psaní těchto rozšíření, a to jak psaní 

maker přímo ve vývojovém prostředí integrovaném do Outlooku a programovacím jazyce Visual 

Basic for Application (VBA), tak také psaní C O M Add-in ve vývojovém prostředí Visual Studio 

2008 na architektuře Visual Studio Tools for Offce (VSTO). Programovací jazyk pro C O M Add-in 

jsem zvolil C#. 

Na názorných příkladech, včetně ukázek zdrojových kódů a výsledků činnosti napsaného 

pluginu, jsem ukázal všechny základní možnosti přizpůsobení si MS Outlook, zejména pak vytváření 

menu a toolbaru, úpravy kontextového menu a Ribbon menu. Předvedl jsem práci se základními 

komponentami (složky, email, kalendář), jak je vytvářet, mazat a upravovat. Prošel jsem krok za 

krokem postup při vytváření pluginu od založení nového projektu ve Visual Studiu, až po spuštění 

napsaného kódu. 

Formu textu práce jsem zvolil tak, aby byl srozumitelný pro ty, kteří chtějí s psaním pluginu 

teprve začít a doposud nemají žádné zkušenosti s tímto tématem. Spousta příkladů z této práce jsou 

využitelné nejen pro Outlook, ale dají se využít i v dalších aplikacích ze sady MS Office. Umožnit 

budoucím vývojářům, rychle se zorientovat v daném tématu a ukázat základní prvky při tvorbě 

pluginu tak, aby mohli rychleji přejít k vývoji svého pluginu. 
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Seznam příloh 
A. Struktura dat na přiloženém 

B. CD s ukázkovými kódy 



Příloha A: Struktura dat na přiloženém CD 
Tato příloha popisuje obsah CD nosiče, na kterém jsou umístěny zdrojové kódy a technická 

zpráva k této práci. 

Složka nazvaná: "Ukázky C O M Add-in" obsahuje Visual Studio 2008 projekty včetně 

zdrojových kódů příkladů. Podsložky jsou nazvány čísly, odpovídající číslům kapitol, ve kterých byla 

daná ukázka použita. 

Složka nazvaná:"Ukázky V B A " obsahuje soubor "VbaProject.otm", ve kterém je kód 

příkladů použitý v kapitole 2. 

Složka "Dokumentace" obsahuje technickou zprávu pod názvem BP.pdf 
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